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C H A P T E R 2

Working with the Cisco ANA NetworkVision 
Client

The following topics describe the user access roles required to use Cisco ANA NetworkVision, the 
Cisco ANA NetworkVision working environment, and how to access the Cisco ANA NetworkVision 
tools and commands:

• User Roles Required to Work with Cisco ANA NetworkVision, page 2-1

• Starting Cisco ANA NetworkVision, page 2-2

• Cisco ANA NetworkVision Window, page 2-4

• Changing a User Password in Cisco ANA NetworkVision, page 2-38

• Selecting Cisco ANA NetworkVision Map and Alarm Options, page 2-39

• Working with Cisco ANA Tables, page 2-40

User Roles Required to Work with Cisco ANA NetworkVision
Table 2-1 identifies the GUI default permission or device scope security level that is required to work 
with Cisco ANA NetworkVision. Cisco ANA determines whether you are authorized to perform a task 
as follows: 

• For GUI-based tasks (tasks that do not affect devices), authorization is based on the default 
permission that is assigned to your user account. 

• For device-based tasks (tasks that do affect devices), authorization is based on the default 
permission that is assigned to your account. That is, whether the device is in one of your assigned 
scopes and whether you meet the minimum security level for that scope. 

For more information on user authorization, see the Cisco Active Network Abstraction 3.7.1 
Administrator Guide.
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Starting Cisco ANA NetworkVision
This topic provides instructions for launching the Cisco ANA NetworkVision application. Cisco ANA 
NetworkVision is password protected to ensure security. Before you start working with Cisco ANA 
NetworkVision, make sure you know your username, password, and the Cisco ANA gateway IP address 
or hostname that you require.

Note If you do not log into the Cisco ANA Manage, Cisco ANA NetworkVision, or Cisco ANA EventVision 
application during a specified period of time (the default is one month), your account is automatically 
locked. The default period can be changed per user in Cisco ANA Manage. The period of time is 
measured from the time you last logged out of any of the Cisco ANA client applications.

Note When working intensively on Cisco ANA NetworkVision or Cisco ANA EventVision, you might 
experience a Java crash causing the GUI application to close.  This issue does not affect the Cisco ANA 
server and is related only to the Java GUI applications running on a Windows machine with some models 
of graphics cards.

This situation can occur while working with multiple open windows of Cisco ANA applications and 
occurs sporadically with no specific scenario. 

If you encounter this situation, do either of the following:
- Restart the Cisco ANA application. 
- Consider updating your graphics card driver. 

To start Cisco ANA NetworkVision:

Step 1 Choose Start > Programs > Cisco ANA > Cisco ANA NetworkVision.

The Cisco ANA NetworkVision Login dialog box is displayed. The last four Cisco ANA gateways you 
logged into are displayed in the Host drop-down list. The list is displayed in chronological order with 
the most recent Cisco ANA gateway at the top of the list.

Table 2-1 Default Permission/Security Level Required for Cisco ANA 

NetworkVision Functions

Task Viewer Operator OperatorPlus Configurator Administrator

Start Cisco ANA 
NetworkVision

X X X X X

Change a user password 
in Cisco ANA 
NetworkVision

— — — — X1

1. Each user can change their own password, but only the Administrator role can change another user’s password.

Set Cisco ANA 
NetworkVision options

X X X X X

Work with Cisco ANA 
NetworkVision tables

X X X X X
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Step 2 Enter your username and password. 

Step 3 Choose a Cisco ANA gateway in either of the following ways:

• Enter an IP address or hostname in the Host field.

• Select a Cisco ANA gateway from the Host drop-down list. (The Cisco ANA gateway IP address or 
hostname that was used when you last logged in is automatically displayed at the top of the Host 
drop-down list.)

Note Make sure that you use the leading IP address (the IP address on which the Cisco ANA gateway 
was configured) when logging into the system.

Step 4 Click OK. 

If any client updates are available, Cisco ANA automatically installs them.

When you launch Cisco ANA NetworkVision, messages are displayed if the server and client have 
different versions of the application that launches the client. For more information about these messages, 
see the Cisco Active Network Abstraction 3.7.1 Installation Guide. 

The Cisco ANA NetworkVision window appears empty when it is opened for the first time. You can 
create a new map or open a map that has been previously saved; see Chapter 4, “Working with 
Cisco ANA NetworkVision Maps,” for information on network maps.

After logging into Cisco ANA NetworkVision and launching the application, you can customize the 
Cisco ANA NetworkVision settings. For example, you can:

• Load the content pane with information when starting Cisco ANA NetworkVision.

• Display network elements in the Cisco ANA NetworkVision content pane and navigation pane.

• Configure audio responses when different alarms are triggered.

For more information on customizing Cisco ANA NetworkVision startup and display options, see 
Selecting Cisco ANA NetworkVision Map and Alarm Options, page 2-39. 
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Cisco ANA NetworkVision Window
Figure 2-1 displays the Cisco ANA NetworkVision window with an open map.

Figure 2-1 Cisco ANA NetworkVision Window 

The content pane, ticket pane, and navigation pane are the three main components of the Cisco ANA 
NetworkVision user interface.

Note The ticket pane can be displayed or hidden by clicking the arrows below the navigation pane.

The status bar at the bottom of the window provides information about the current connection status for 
the view. The status bar also displays what is happening to the command that was sent while the 
application waits for an answer.

1 Menu bar 5 Ticket pane

2 Toolbar 6 Hide/display ticket pane

3 Content pane (showing the map view) 7 Navigation pane

4 Status bar
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The memory utilization bar in the status bar displays the amount of memory used by the client. By 
default, if memory utilization exceeds 60%, it is colored yellow, and if it exceeds 80%, it is colored red. 

Dragging the borders of the Cisco ANA NetworkVision window adjusts the size of each pane. The 
navigation pane and content pane are correlated; this means that selecting an option in the navigation 
pane affects the information displayed in the content pane.

Some of the functions that the Cisco ANA NetworkVision window enables you to perform are:

• View the network.

• View network element properties.

• View physical and logical inventory information.

• View a complete list of the physical links and their status.

• View link properties.

• View and manage tickets.

Navigation Pane
The navigation pane displays a tree-and-branch representation of the network elements and aggregations 
defined for the loaded map.

The highest level in the navigation tree displays the map name (for example, the name of a geographic 
area). When the map name is changed, the Cisco ANA NetworkVision window is updated. The new map 
name is displayed, between brackets, at the top of the navigation tree, and in the title bar of the window.

The lowest level of the navigation tree displays a single NE (for example, a router and the device name, 
or the name of the business tag). 

For information about the status of network objects, see Network Element Status Indicators, page 2-17.

Content Pane: Map, List, and Links Views
The content pane enables you to view and modify low-level information. It supports the following views: 

• Map view—Displays managed network elements on a geographical map. For more information, see 
Map View, page 2-6.

• List view—Displays the details of the network elements contained in the currently selected 
hierarchy or subnetwork (map), such as the IP address and system name. For more information, see 
List View, page 2-10.

• Links view—Displays a complete list of the links shown in the map view and their status. For more 
information, see Links View, page 2-13.

When you switch between the map, list, and links views, the following are preserved:

• The currently selected network elements or links.

• The sorting preferences.

• The filtering preferences, as defined using:

– The Map Options dialog box—See Filtering Links According to Type, page 4-24.

– The Filter dialog box—See Filtering Table Contents, page 2-43.

– The links view collection method—See Filtering Links Using the Collection Method, 
page 5-14.
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Map View

Click Show Map View on the toolbar to display the map view in the Cisco ANA NetworkVision window.

In the map view, Cisco ANA NetworkVision displays:

• Managed network elements

Each NE is displayed using an NE icon, the color of which reflects severity, as described in Severity 
Indicators, page 2-10. In addition, a management state or alarm icon is displayed with the IP 
address. A tooltip displays the NE name, NE type, and IP address.

• VLANs

• VPNs

• Links and link aggregations 

The links (and link aggregations) that are presented in the map view: 

– Display arrowheads if they are unidirectional. 

– Do not have arrowheads if they are bidirectional. 

• Relationships between network elements, aggregations, and networks

Note If the maximum number of links is exceeded, a warning message is displayed, all links are removed from 
the map, and the map is surrounded by a red border. 

You can view the links in either of the following ways: 
- Choose Show Links view in the toolbar. 
- Filter the links to reduce the number of links that are to be displayed. This filtering allows the client to 
return to a normal state.

For more information on the maximum number of links, contact your Cisco account representative.

The links have tooltips that provide you with information regarding the number of links that are 
represented by a line, along with partial descriptions. Physical links are highlighted in bold. Because a 
single link may actually represent a number of links, you can use the links view to get more details (see 
Links View, page 2-13).

For more information about links in Cisco ANA NetworkVision, see Chapter 5, “Working with Links.”

Note If you apply a link filter to the map, the Links tooltip displays only the relevant links.

The map view enables you to view network objects down to the device level. An example of the map 
view is displayed in Figure 2-1.

You can move the NEs manually on the map by dragging the required NE. You can also click Layout 
Map in the toolbar or choose View > Zoom In or View > Zoom Out to change the way NEs are 
displayed on the map.
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Right-Click Functions

Table 2-2 describes some of the functions that can be performed using the right-click shortcut menu in 
the map view, including launching external applications or tools. Some of these functions are also 
available in the navigation pane, links view, and ticket pane.

Table 2-2 Right-Click Functions in Map View

Right-Click Functions Available from Map View For more information, see:

Go to Parent Goes to the parent in the tree pane and map pane 
so you can view different information.

Go to Root Goes to the root in the tree pane and map pane so 
you can view different information.

Aggregate network elements Chapter 4, “Working with Cisco ANA 
NetworkVision Maps”

Change the view and content of network maps Chapter 4, “Working with Cisco ANA 
NetworkVision Maps”

Communicate with network elements Chapter 4, “Working with Cisco ANA 
NetworkVision Maps”

Configure the topology Chapter 5, “Working with Links”

Create and attach business tags Chapter 6, “Working with Business Tags and 
Business Elements”

Create and view tickets Chapter 9, “Working with Tickets in Cisco ANA 
NetworkVision”

Filter tickets Chapter 9, “Working with Tickets in Cisco ANA 
NetworkVision”

Generate reports on events, inventory, and 
networks services

Chapter 10, “Working with Reports”

Launch external applications or tools from 
Cisco ANA NetworkVision navigation tree, map 
pane, links view, and ticket pane

Cisco Active Network Abstraction 3.7.1 
Customization User Guide

Launch components installed with Cisco ANA:

• Cisco Active Network Abstraction 
Configuration and Image Management

• Cisco Active Network Abstraction Network 
Service Activation

• Cisco Active Network Abstraction 3.7.1 
Configuration and Image Management User 
and Administrator Guide

• Cisco Active Network Abstraction Network 
Service Activation 1.1 User Guide

Launch available activation and configuration 
scripts, including those you create using 
Cisco ANA Command Builder (can be launched 
against multiple NEs)

Cisco Active Network Abstraction 3.7.1 
Customization User Guide

View device inventory Chapter 3, “Viewing Network Element 
Properties”

View NE information (device properties) Chapter 3, “Viewing Network Element 
Properties”
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Network Element Icons

Table 2-3 identifies the icons used to represent network elements in the Cisco ANA NetworkVision 
window’s navigation pane and content pane. 

Table 2-3 Network Element Icons

Icon Device

ATM switch 

Basic rate access (BRA)

Connection termination point (TP)

Ethernet flow point

Cross-connect

Digital subscriber line access multiplexer (DSLAM) 

Ethernet service

Ethernet switch 

Ethernet virtual connection (EVC)

Generic SNMP

Logical Circuit Aggregation (LCA) business element

Logical Circuit Peer (LCP) business element

Logical Circuit Peer with one or more hidden connected devices

Network pseudowire

Network, subnetwork, or logical aggregation

Pseudowire switching entity

Switching entity
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Note When Cisco ANA NetworkVision detects a network device for which it does not have enough 
information available, Cisco ANA NetworkVision displays as a ghost device on the map. When this 
occurs, you cannot view the ghost device properties or communicate with it. When the information for 
the ghost device becomes available, Cisco ANA NetworkVision replaces its icon with the relevant device 
icon, and all the related device information and communication become available.

Router 

Site

Site with one or more hidden connected devices

Unknown, or ghost, device

Unmanaged network or cloud

Viewable by a user with a higher permission level

Virtual router

VLAN

VPLS

VPN

VSI

Table 2-3 Network Element Icons (continued)

Icon Device
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Severity Indicators

Table 2-4 shows the colors that are used to display the severity (or propagated severity) of a network 
device in the navigation, content, and ticket panes. 

The same coloring conventions apply to the link severity displayed in the map and links views. 

Note The color of a selected link can be customized. The default color is blue.

When an aggregated node is selected in the navigation tree, the content pane displays the elements 
contained within the aggregation and the relationships between them.

For more information about how the status of a network element is displayed in a map, see Network 
Element Status Indicators, page 2-17.

List View

Click Show List View in the toolbar to display the Cisco ANA NetworkVision list view. The list view 
displays the tabs described in Table 2-5, depending on the items included in the current map and the item 
selected in the navigation tree. 

Table 2-4 Severity Indicators

Icon Color Severity

Red Critical

Orange Major

Yellow Minor

Sky Blue Warning

Green Cleared, Normal, or OK

Dark Blue Information 

White Indeterminate

Table 2-5 Cisco ANA NetworkVision List View Tabs

Tab Description

Aggregations Aggregations contained in the current map.

Connection TP Connection termination points (TPs) contained in the current map.
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Table 2-6 describes the network element properties displayed in Network Elements tab. (Locked network 
elements display only managed element information and the locked device icon.)

EFP Cross-Connect EFP cross-connects contained in the current map.

Ethernet Flow Points EFPs contained in the current map.

Ethernet Services Ethernet services contained in the current map.

EVCs EVCs contained in the current map.

Network Elements Network elements contained in the current map.

Network Pseudowire Network pseudowire contained in the current map.

Pseudowires Pseudowires contained in the current map.

Pseudowire Edge Pseudowire endpoints contained in the current map.

PW Switching Entity Pseudowire switching entities contained in the current map.

Sites Sites for the selected VLAN. Site properties include site name, description, 
location, and IP interface.

Switching Entities Switching entities contained in the current map.

Virtual Routers Virtual routers on the selected VLAN. Virtual router properties include the 
virtual router name and description.

VLANs VLANs contained in the current map. VLAN properties include VLAN 
name, ID, description, and Ethernet flow points.

VPLS Forward VPLS forwards contained in the current map.

VPLS Instance VPLS instances contained in the current map.

VPNs VPNs contained in the current map. VPN properties include VPN name and 
description

Table 2-5 Cisco ANA NetworkVision List View Tabs (continued)

Tab Description

Table 2-6 Network Element Information Displayed in List View

Field Name Description

Name Name of the network element managed by Cisco, as defined in Cisco ANA 
Manage. The Name property also displays a network element icon. The icon 
color reflects the highest network element alarm severity. In addition, the 
management state or an alarm icon is displayed.

IP Address IP address used for managing the network element. 

System Name System name of the network element, as defined in the network element's 
MIB. If the network element is configured for Telnet access, the prompt is 
displayed.

Communication State Ability of the VNE to reach the network element, according to the health of 
the device. For more information about communication states, see the 
Cisco Active Network Abstraction 3.7.1 Administrator Guide.

Investigation State Level of network element discovery that has been performed or is being 
performed by the VNE. For more information about investigation states, see 
the Cisco Active Network Abstraction 3.7.1 Administrator Guide.
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Tip Click the red triangle in a cell to expand the cell and view all the information it contains. You can also 
use a tooltip to view all the information.

Table 2-7 identifies the buttons that are displayed in the list view toolbar.

Element Category Network element category, such as Router or Eth-Switch (Ethernet switch).

Element Type Network element type including the manufacturer’s name, such as 
Cisco 7200.

Vendor Vendor name.

Up Since Date and time when the network element was last reset.

System Description Detailed description of the software installed on the network element.

Location Location of the network element.

File Systems Device file systems. 

Sending Alarms Whether the network element is configured for sending alarms: True or 
False. 

Reporting the status of alarms can be enabled on only part of the device.

Table 2-6 Network Element Information Displayed in List View (continued)

Field Name Description

Table 2-7 List View Toolbar

Icon Name Description

Export to CSV Exports the information displayed in the table, or selected 
portions, to a CSV file. 

For more information, see Exporting Tables to a File, page 2-45

Sort Table Values Sorts the information displayed in the table by the criteria you 
specify. 

For more information, see Sorting a Table, page 2-42.

Filter Filters the information displayed in the table by the criteria you 
specify. 

For more information, see Filtering Table Contents, page 2-43.

Clear Filter Clears the existing filter. 

Show All Rows Displays all table rows that meet the current filtering criteria.

Show Only Selected 
Rows

Displays only the rows that you select. 

For more information, see Viewing Selected Rows, page 2-45.
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See Working with Cisco ANA Tables, page 2-40, for more information about filtering, finding details 
about a network element in Cisco ANA NetworkVision tables, and the keyboard shortcuts used for 
accessing table functionality.

Some of the options that are available in the right-click shortcut menu in the list view are:

Tip Click a column heading in a table to sort the information by that property.

Links View

Click Show Links View in the toolbar to display the links view in the Cisco ANA NetworkVision 
window.

When you view a map, it might have many links, and some links might consist of a collection, or 
aggregation, of links. This can make it difficult for you to view the links you are interested in. The links 
view enables you to clearly view the links, search for a specific link, and view the status of a link. 

Note You can view and filter the links according to type using the Map Options dialog box. For more 
information, see Filtering Links According to Type, page 4-24.

Any links that are added or removed from the map are automatically added or removed from the links 
view, provided they have not been filtered out. 

The links view is selection sensitive; that is, the links displayed in the links view depend on the context 
selected in the navigation pane or map. For example, if an aggregated node is selected, the links in the 
selected aggregation are displayed in the links view. 

Option Related Documentation

View network element properties Chapter 3, “Viewing Network Element Properties”

View network element inventory Chapter 3, “Viewing Network Element Properties”

Launch external applications or tools, 
such as an SSH client.

Cisco Active Network Abstraction 3.7.1 Customization 
User Guide

Launch available activation and 
configuration scripts, including those you 
create using Cisco ANA Command 
Builder (can be launched against multiple 
NEs).

Cisco Active Network Abstraction 3.7.1 Customization 
User Guide

Configure the topology. Chapter 5, “Working with Links”

Configure and view business tag 
information.

Chapter 6, “Working with Business Tags and 
Business Elements”
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Figure 2-2 shows a links view.

Figure 2-2 Links View 

Note An external link has a gray cell background in the table, and you can open the inventory window by 
clicking the hyperlink. For more information about external links, see Viewing Link Properties in the 
Links View, page 5-5.

Table 2-8 describes the information that is displayed in the links view.

Table 2-8 Information Displayed in the Links View

Field Name Description

Context Name of the map or aggregated node containing the link. 

Severity Link alarm severity, represented by a bell icon. The color indicates the alarm 
severity and thereby the impact of the alarm on the network. For more 
information about severity, see Map View, page 2-6.

A End-Point Device or site that is the source of the link as a hyperlink to the inventory of the 
device or site.

Bi Directional Whether the link is bidirectional or unidirectional: true (bidirectional) or false 
(unidirectional). If the link is unidirectional (false), the traffic is from A to Z.

Z End-Point Device or site that is the destination of the link as a hyperlink to the inventory of 
the device or site.

Link Type Type of link, such as Physical Layer, VPN, or MPLS.
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Note Clicking a column heading in the links view sorts the information by that header value.

The links view toolbar includes the tools described in Table 2-7 and the link filtering buttons described 
in Table 2-9. 

For more information about filtering and sorting links in the links view, see Viewing Link Properties in 
the Links View, page 5-5.

Ticket Pane
When Cisco ANA detects faulty behavior in the network, the VNEs and their internal device components 
initiate an internal, end-to-end message flow, resulting in the full understanding and containment of the 
fault across all relevant network elements and network layers. 

The ticket pane enables you to view and manage tickets as well as identify elements or links that are 
affected by a ticket. All the tickets that are reported by Cisco ANA are stored in the Cisco ANA gateway 
database.

The ticket pane is displayed beneath the navigation and content panes in the Cisco ANA NetworkVision 
window. You can view or hide the ticket pane by clicking the arrows displayed below the navigation 
pane.

A ticket represents the complete hierarchy of correlated alarms representing a single specific fault 
scenario. A ticket points to the root cause alarm that is the top-most alarm in the correlation hierarchy. 
Examples of alarms are Link Down, Device Unreachable, or Module Out. Some event types are capable 
of creating tickets. When an event is generated, it is correlated to an existing event, which is correlated 
to a ticket. If there is no existing ticket, a new ticket is created.

Note For detailed definitions of the key concepts in fault management, such as tickets, alarms, and events, see 
the Cisco Active Network Abstraction 3.7.1 Theory of Operations Guide. For information on managing 
tickets, see Chapter 9, “Working with Tickets in Cisco ANA NetworkVision.”

Table 2-9 Link Filtering Buttons

Button Name Description

All Links Displays the complete list of links for the selected context (map or 
aggregated node). In other words, the list is not filtered and all the links 
are displayed, including external links. 

External Links Displays links with only one side of the link in this context (map or 
aggregated node) and the other side either not in the map or outside the 
selected context. 

Flat Links 
(Surface) 

Displays the links currently visible on the map for the selected context 
(map or aggregated node), excluding any thumbnails.

Deep Links Displays the links for the current aggregated node where both endpoints 
are within the currently selected context.
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Cisco ANA identifies the relationship between a root cause alarm and its consequent alarms. It 
automatically correlates the consequent alarms as children of the root alarm. The ticket pane displays 
the ticket (the root cause alarm), the aggregated severity of the ticket, and the severity of the root cause 
alarm. The Ticket Properties window enables you to view all correlated alarms.

Note The root cause alarm severity is the top-most severity of its contained alarms.

The ticket pane enables you to perform the following functions:

• View all tickets or only the filtered tickets of a selected device. For more information, see Filtering 
Tickets by Device, page 9-5.

• View and filter all tickets that meet specified criteria. See Filtering Tickets by Criteria, page 9-6.

• View and acknowledge tickets.

• View the properties of a ticket, including the history, correlated alarms, severity of the root cause 
alarm, and affected parties.

• Clear a ticket.

• Remove a ticket.

• Clear and remove a ticket.

• Locate the elements or links affected by the ticket in the map or links view.

• Sort the tickets displayed.

Table 2-10 describes the information displayed in the ticket pane.

Table 2-10 Ticket Information Displayed in the Ticket Pane

Field Name Description

Severity Severity of alarm, represented by a bell icon. The color indicates the alarm 
severity and thereby the impact of the alarm on the network. For more 
information about severity, see Map View, page 2-6.

• Red—Critical

• Orange—Major

• Yellow—Minor

• Sky Blue—Warning

• Green—Cleared, Normal, or OK

• Dark Blue—Informational

• White—Indeterminate

Ticket ID Ticket identifier, assigned sequentially. Click the hyperlinked entry to view 
ticket properties, and to acknowledge, clear, or refresh the ticket. For more 
information, see Chapter 9, “Working with Tickets in Cisco ANA 
NetworkVision.”

Last Modification 
Time

Date and time the ticket was last modified. The ticket is modified when a user 
acknowledges the ticket or when an event is correlated.

Root Cause Severity of the root cause alarm, represented by a bell icon. The color indicates 
the severity of the root cause alarm, as described in the Severity field. 

Description Supported ticket name.
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The ticket details in the ticket pane change automatically as new information arrives. For example, Port 
Down is updated to Port Up.

By default, the tickets in the ticket pane are sorted according to Ticket ID. For information about tickets, 
see Chapter 9, “Working with Tickets in Cisco ANA NetworkVision.”

The Find field enables you to search for information in the ticket pane table according to the selected 
column. For more information about the buttons displayed in Cisco ANA NetworkVision tables and 
table functionality, see Working with Cisco ANA Tables, page 2-40.

The Location bar below the table displays:

• The location of the selected rows in the table; for example, Line 3.

• The number of selected rows and the total number of rows in the table; for example, 2/16 Selected.

For more information about network element status indicators, see Network Element Status Indicators, 
page 2-17.

Network Element Status Indicators
The following topics describe the ways in which the status of a network element is displayed in 
Cisco ANA NetworkVision:

• Severity, page 2-18

• Network Element Management State, page 2-19

• Tickets, page 2-22

Location Entity that triggered the ticket, as a hyperlink that displays the relevant location 
in the inventory.

Acknowledged Whether or not the ticket has been acknowledged: Yes or No. 

Event Count Number of events associated with the ticket.

Affected Devices 
Count

Number of devices affected by the ticket, including the sources of the alarm 
and their subsequent alarms.

Duplication Count For network events, the duplication count is calculated by the VNE and 
pertains only to flapping events. The duplication count represents the number 
of noncleared events aggregated by the flapping event. 

For tickets, the duplication count is the sum of the duplication counts of all 
events that are associated with the root alarm. 

Reduction Count For network events, the reduction count is calculated by the VNE and pertains 
only to flapping events. The reduction count represents the number of events 
that are aggregated by the flapping event. 

Ticket reduction count is the sum of reduction counts of all the events that are 
associated to the ticket. The History tab in the Windows Properties window 
displays one reduction count for each event listed. For more information, see 
Chapter 9, “Working with Tickets in Cisco ANA NetworkVision.”

Alarm Count Total number of alarms associated with the ticket, including the root alarm. 

Table 2-10 Ticket Information Displayed in the Ticket Pane (continued)

Field Name Description
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Severity

Severity indicates the operational health of the network element. An icon has only one severity value at 
any given time, and this value is displayed using the severity colors. For more information about the 
colors used to display the severity (or propagated severity) of network elements and links, see Severity 
Indicators, page 2-10.

Propagation

Severity is propagated upward in the network hierarchy, displaying the top-most severity of the NE’s 
children and thereby ensuring that every single problem in the network is propagated and visible.

The same severity propagation rules that are used for network elements apply to links. A link is a child 
object of an aggregation only if it is fully contained in the aggregation; that is, the network elements on 
both sides of the link are part of the aggregation, as shown in Figure 2-3 and Figure 2-4.

Figure 2-3 Link Severity Example 1

Figure 2-3 shows critical link 1 between two NEs in an aggregation. This critical link affects the severity 
of aggregation 2. That is, the aggregation is critical because it contains a link with a critical severity. 
Link severity affects the context.

Figure 2-4 Link Severity Example 2

Figure 2-4 shows critical link 1 that forms part of a link aggregation. This affects the severity of link 2 
because it contains a link with a critical severity.

New Ticket Propagation

A new ticket indicates a new local fault or accumulates and propagates the number of new faults in its 
children. New tickets are propagated upward, displaying the number of new tickets and the top-most 
severity.

When new tickets are accumulated, a label is displayed in the navigation pane and map, based on the 
following formula:

n s [+]

where: 

1 2

18
01

11

1 2

18
01

12
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For example:

• An object with three critical new alarms, two major alarms, and one warning alarm is labeled 3C+.

• An object with five minor new alarms is labeled 5m.

A bell represents unacknowledged tickets, and the bell color is that of the most severe, unacknowledged 
ticket. 

If all relevant tickets are acknowledged, no bell is displayed. 

Network Element Management State

The management state indicates the state or mode of the software component (a VNE) managing an NE 
and the communication with it. This enables you to determine the accuracy of the network information 
and the availability of VNEs to carry out network operations. 

Management states are always local indications and are not propagated. A partial exception to this rule 
is the propagation of unreachable network elements. 

The management state indication applies only to network elements and network element components. A 
network object can have only one state (for example, Unsupported or Initializing).

A managed network element icon consists of a managed element icon and one or two overlay icons, or 
badges:

• The managed element icon displays a symbol of the element, and the color of the symbol indicates 
the highest severity ticket that is not cleared for the element. For more information about network 
element icons, see Network Element Icons, page 2-8. For more information about severity colors, 
see Severity Indicators, page 2-10.

• An alarm badge (a bell) is displayed on top of a managed element icon, and the color of the alarm 
badge indicates the severity of the highest severity ticket that is not acknowledged for the element. 
If all tickets are acknowledged, no alarm icon appears. 

Figure 2-5 shows an example of an element with the following ticket and alarm severities: 

– The highest severity ticket that is not cleared for the element is Major, as indicated by the orange 
color applied to the element icon.

– The highest severity alarm that is not acknowledged for the element is Minor, as indicated by 
the yellow alarm badge. 

Symbol Description

n The number of tickets with the highest severity in the new ticket count.

s The highest severity level in the new tickets:

• C = Critical

• M = Major

• m = Minor

• W = Warning

• N = Normal (cleared alarm)

• i = Informational

+ Additional, less severe tickets (optional) exist.
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Figure 2-5 Element with Ticket and Alarm Severity Indicators

• A VNE management state badge is displayed on top of the managed element icon to indicate the 
management state in the navigation tree and map. For example, a router that Cisco ANA failed to 
access (the router is unreachable) is displayed as illustrated in Figure 2-6. 

Figure 2-6 Element with Overlay Badges

Table 2-11 describes network element communication and management states and shows the related 
badge for each state.

1 Element icon with severity Major (orange)

2 Alarm badge with severity minor (yellow)

1 2

19
88

59

1 Alarm badge

2 Managed element icon

3 VNE management state badge

1

2

3 18
01

57

Table 2-11 Network Element Communication and Management States

State Name Description Badge 

Communication States

Device Reachable All element protocols are enabled and connected. None

Device Partially 
Reachable

The element is not fully reachable because:

• At least one protocol is not operational.

• All protocols are not operational but the element is still sending 
syslogs or traps.

Device Unreachable No protocols are responding and the element has not sent traps or 
syslogs in the last three minutes. 

VNE/Agent 
Unreachable

The VNE is not responding to the gateway. This can occur if the unit 
or AVM is overutilized or the connection between the gateway and 
unit or AVM was lost. 
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More than one management state can occur at the same time. For example, a single overlay icon can be 
displayed, reflecting the device status based on the following priorities: Unsupported > Discovering > 
VNE/Agent Unreachable > Device Unreachable > Partially Discovered > Operational.

Connecting The VNE is starting and the initial connection has not yet been made 
to the device. This is a momentary state.

None

Investigation States

Defined Not Started The initial state of the VNE, as soon as it is created. 

The VNE was created but not started, or an existing VNE was 
stopped. A VNE remains in this state until it is started by a user. In 
this state, the VNE is managed but does not yet have any device 
information because the VNE has not yet connected to the device. 

None

Unsupported The device type is not supported by Cisco ANA, specifically 
because no VNE driver was found for the device.

Discovering The VNE is building the model of the device (the device type was 
found and is supported by Cisco ANA). 

Operational The VNE has a stable model for the device. Modeling might not be 
fully complete, but enough information exists to monitor the device.

None

Currently 
Unsynchronized

The VNE model is inconsistent with the element for one of the 
following reasons:

• A required, recoverable device command failed.

• The device did not respond in a timely manner.

• The VNE was in maintenance state but has restarted and is now 
resynchronizing with the network element.

• The VNE was in the Device Unreachable state and is now 
resynchronizing with the network element. 

Maintenance The VNE is no longer polling the device; therefore, the VNE does 
not know the device status. This can occur when a user moves the 
VNE to maintenance mode, or the VNE is using adaptive polling 
and CPU information is too high. 

Partially Discovered The VNE model is inconsistent with the device because a required 
device command failed three times. A common cause of this state is 
that the device contains an unsupported module. 

Reconciliation The business element with this badge is associated with a network 
element that does not exist. For example, the device configuration 
has changed and a network problem exists. 

Shutting Down The VNE has been stopped or deleted by the user, and the VNE is 
terminating its connection to the device.

Stopped The VNE process has terminated; it will immediately move to 
Defined Not Started.

None

Table 2-11 Network Element Communication and Management States (continued)

State Name Description Badge 
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For more information about each of these states and how to troubleshoot any issues, see the Cisco Active 
Network Abstraction 3.7.1 Administrator Guide.

Tickets

A bell icon is displayed in the navigation, map, and ticket panes to indicate one or more tickets. Every 
alarm is assigned a severity level, representing the impact of the fault on the network device. The bell 
icon displays the severity level of the top-most alarm. The following is an example:

Cisco ANA NetworkVision Toolbar
The Cisco ANA NetworkVision toolbar is context-sensitive and the options vary depending on your 
selection in the application. 

Note The functionality that a user can access from the toolbar and in menus depends on the permissions 
defined for the user.

Table 2-12 identifies the icons and describes the functions that are available in the Cisco ANA 
NetworkVision toolbar.

Value Navigation Pane Map

Ticket

Table 2-12 Cisco ANA NetworkVision Toolbar

Button Name Function

Map Options

New Map Creates a new map in the database.

Open Map Opens a map saved in the database using the Open dialog box.

Add to Map Adds an element to the map or to the subnetwork selected in the 
navigation pane and displayed in the content pane.

Save Map 
Appearance

Saves the current map (the background and the location of devices) 
to the database.

Viewing Options

Show Map View Displays the map view in the Cisco ANA NetworkVision content 
pane (the button toggles when selected or deselected).

Show List View Displays the list view in the Cisco ANA NetworkVision content 
pane (the button toggles when selected or deselected).

Show Links View Displays the links view in the Cisco ANA NetworkVision content 
pane (the button toggles when selected or deselected).
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Overlay Tools

Choose Overlay 
Type

Chooses and displays an overlay of a specific type on top of the 
elements displayed in the content pane in a map view. 

Available overlay options are:

• Ethernet Service

• Pseudowire

• VLAN

• VPLS

• VPN

• None—Removes the existing overlays.

Show Overlay / 
Hide Overlay

Displays or hides a previously defined overlay on top of the 
elements displayed in the map view.

Note Overlays do not reflect changes that occur in the selected 
service. As a result, the information in an overlay can 
become stale. 

Refresh Overlay Refreshes the overlay that was last selected.

Navigation Tools

Go to Parent Moves up a branch in the navigation pane and content pane to 
enable you to view different information.

Link Filter Opens the Map Options dialog box, enabling you to display or hide 
different types of links in the map and links views.

Overview Opens a window displaying an overview of the network.

Find Previous Finds the previous instance of the search string entered in the Find 
in Map dialog box.

Find Opens the Find in Map dialog box, enabling you to find a device or 
aggregated node in the map by its name or IP address.

Find Next Finds the next instance of the search string entered in the Find in 
Map dialog box.

Find Business Tag Opens the Find Business Tag dialog box, enabling you to find and 
delete a business tag according to name, key, or type.

Map Zoom and Layout Tools

Layout Map Defines the way in which the NEs are arranged in the Cisco ANA 
PathTracer window: circular, symmetric, tree, or hierarchical.

Fit in Window Fits the entire subnetwork or map in the content pane.

Table 2-12 Cisco ANA NetworkVision Toolbar (continued)

Button Name Function
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Cisco ANA NetworkVision Menu Bar
The following topics describe the options that are available in each Cisco ANA NetworkVision menu:

• File Menu, page 2-25

• Edit Menu, page 2-25

• View Menu, page 2-26

• Node Menu, page 2-26

• Tools Menu, page 2-27

• Network Inventory Menu, page 2-28

• Reports Menu, page 2-28

• Window Menu, page 2-29

• Help Menu, page 2-29

Note Based on the security level and access permissions assigned to a user, some of the menu options may not 
be available. 

Note The menus are context-sensitive and the options vary depending on your selection in the application.

Normal Selection 
Mode

Activates the normal selection mode (the button toggles when 
selected or deselected).

Zoom Selection 
Mode

Activates the zoom selection mode, which enables you to select a 
pane in the map to enlarge by clicking and dragging (the button 
toggles when selected or deselected).

Pan Mode Activates the pan mode, which enables you to move around in the 
map by clicking and dragging (the button toggles when selected or 
deselected).

Application-Specific Tools

Open Activation Displayed if Cisco ANA Network Service Activation is installed 
with Cisco ANA. 

Opens the Activation dialog box. 

For more information, see the Cisco Active Network Abstraction 
Network Service Activation 1.1 User Guide.

Show Recent 
Activations

Displayed if Cisco ANA Network Service Activation is installed 
with Cisco ANA. 

Opens the Service Activation List dialog box. 

For more information, see the Cisco Active Network Abstraction 
Network Service Activation 1.1 User Guide.

Table 2-12 Cisco ANA NetworkVision Toolbar (continued)

Button Name Function
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File Menu

Table 2-13 describes the options that are available in the Cisco ANA NetworkVision File menu. For 
more information, see Chapter 4, “Working with Cisco ANA NetworkVision Maps.”

Edit Menu

Table 2-14 identifies the options available in the Cisco ANA NetworkVision Edit menu. For more 
information, see Chapter 4, “Working with Cisco ANA NetworkVision Maps.”

Table 2-13 File Menu Options

File Menu Option Description

New Map Creates a new empty map in the database.

Open Opens a map saved in the database using the Open dialog box.

Close Closes the map that is currently displayed.

Load MultiPath Loads a Cisco ANA PathTracer map from a previously saved file in the 
Cisco ANA PathTracer Multi-Path window.

Add to Map Opens the Add dialog box and enables you to add any of the following to the map 
or to the subnetwork selected in the navigation pane and displayed in the content 
pane: 

• Cross-Connect

• Ethernet Service

• Network Element

• Pseudowire

• Unassociated Bridge

• VLAN

• VPLS

• VPN

This option is enabled when a map is open and you have the required security 
level (OperatorPlus).

Save Map Saves the appearance of the map (the background and the location of devices) to 
the database. This option is enabled when a map is open and you have the relevant 
security level (OperatorPlus).

Save As Image Saves the active map as an image and automatically displays the Save as Image 
dialog box. Use this dialog box to save an image using a different file format or 
name. 

Print Preview Displays each map as it will look when printed.

Print Prints the active map as displayed in the Print Preview dialog box.

Exit Exits the Cisco ANA NetworkVision application and saves the content pane.
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View Menu

Table 2-15 identifies the options available in the Cisco ANA NetworkVision View menu. For more 
information, see Viewing the Network Map, page 4-15.

Node Menu

Table 2-16 describes the Node menu options.

Note Most of the functionality available in this menu is only available when a device icon or an aggregated 
node is selected in the navigation pane or a map.

Table 2-14 Edit Menu Options

Edit Menu Option Description

Find in Map Searches for a device in the map that contains the specified text in the name or 
the IP address fields.

Find Business Tag Searches for business tag information in the database.

Resize Displays the Resize dialog box, enabling you to define the percentage used to 
resize device icons or aggregated nodes in the map.

Note The Resize option is only available when device icons or aggregated 
nodes are selected.

Table 2-15 View Menu Options

View Menu Option Description

Layout Defines the way in which the map is displayed in the Cisco ANA NetworkVision 
content pane: circular, symmetric, tree, or hierarchical.

Overview Opens a window displaying an overview of the network map.

Zoom In Zooms in on the network map.

Zoom Out Zooms out of the network map.

Fit In Window Displays the entire network map in the content pane. 

Normal Select Activates the normal selection mode. The selected option is dimmed.

Pan Activates the pan mode, which enables you to move around in a map by clicking 
and dragging. The selected option is dimmed.

Zoom Selection Activates the zoom selection mode, which enables you to select an area in a map 
to be enlarged by clicking and dragging to view the selected area. The selected 
option is dimmed.
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Tools Menu

Table 2-17 describes the Tools menu options.

Table 2-16 Node Menu Options

Node Menu Option Description

Inventory Displays a dialog box that enables you to view the physical and logical inventory. 
For physical inventory, you can view all the components of the device, such as 
modules and ports. In addition, you can view the status of each component. For 
logical inventory, you can view all the profiles and virtual channels or routing 
tables of the device. For more information, see Chapter 3, “Viewing Network 
Element Properties.”

Aggregate Groups selected items into an aggregation in the Cisco ANA NetworkVision 
content pane, and enables you to define a name for the aggregation. For more 
information, see Chapter 4, “Working with Cisco ANA NetworkVision Maps.”

Disaggregate Ungroups the selected aggregated node in the navigation pane and a map of the 
Cisco ANA NetworkVision window. All the aggregations in the selected node 
move up one level, and the original aggregated node is removed. For more 
information, see Chapter 4, “Working with Cisco ANA NetworkVision Maps.”

Note This option is available only when an aggregated node is selected in the 
navigation or a map.

Mark as A Side Starts the process of creating a new static link. This option is enabled when a 
device, port or unmanaged network is selected.

Mark as Z Side Launches the Add Static Link dialog box, enabling you to create a static link 
between the two selected nodes. This option is enabled after a device, port or 
unmanaged network is selected and after the Mark as A Side option is selected.

Note If you select two ports, the Add Static Link dialog box is not displayed.

Properties Displays a dialog box enabling you to view the properties of the selected device, 
such as the severity, IP address, and communication state. For more information, 
see Chapter 3, “Viewing Network Element Properties.”

Table 2-17 Tools Menu Options

Tools Menu Option Description

Change User 
Password

Enables you to change the password used when logging in to the Cisco ANA 
client application suite. The change takes effect the next time you log into the 
application.

Note The administrator can also change a user password in Cisco ANA 
Manage.

Options Enables you to customize several of Cisco ANA NetworkVision’s options, such 
as whether or not to load the content upon startup. For more information, see 
Selecting Cisco ANA NetworkVision Map and Alarm Options, page 2-39.

Config and Image 
Mgmnt

Displays the Cisco Active Network Abstraction Configuration and Image 
Management dashboard.

For more information, see the Cisco Active Network Abstraction 3.7.1 
Configuration and Image Management User and Administrator Guide.
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Activation Menu

The Activation menu is displayed if the Cisco ANA Network Service Activation application is installed 
with Cisco ANA. 

See the Cisco Active Network Abstraction Network Service Activation 1.1 User Guide for more 
information about any of the options in this menu.

Table 2-18 describes the Activation menu options.

Network Inventory Menu

Table 2-19 describes the Network Inventory menu options. 

Reports Menu

Table 2-20 describes the Reports menu options. 

For more information about Report Manager and reports, see Chapter 10, “Working with Reports.” 

Table 2-18 Activation Menu Options

Activation Menu 
Option Description

Activation Opens the Activation dialog box.

Show Recent 
Activations

Opens the Service Activation List dialog box. 

Service 
Modification 
Utility

Opens the Service Metadata Modification Utility dialog box. 

Table 2-19 Network Inventory Menu Options

Network Inventory 
Menu Option Description

Ethernet Flow 
Domains

Opens the Ethernet Flow Domain List Properties window, which lists the 
domains. For more information, see Viewing and Renaming Ethernet Flow 
Domains, page 12-30

VTP Domains Enables you to view a current snapshot of the VLAN Trunk Protocol (VTP) 
domains. See Viewing VLAN Trunk Group Properties, page 12-57.

Table 2-20 Reports Menu Options

Reports Menu Option Description

Report Manager Opens the Reports Manager window so you can create, run, and manage 
reports.

Run Report Enables you to run standard or user-defined events, inventory, and network 
service reports on demand.
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Window Menu

The Cisco ANA NetworkVision Window menu displays the names of all the maps open in the 
Cisco ANA NetworkVision content pane, enabling you to move between the maps. 

Help Menu

Table 2-21 describes the Help menu options.

Cisco ANA NetworkVision Shortcut Menus
Right-clicking a specific area, link, network element, device, or alarm in the Cisco ANA NetworkVision 
window opens the following menus:

• Device Shortcut Menu, page 2-30

• Map Shortcut Menu, page 2-33

• Aggregated Node Shortcut Menu, page 2-33

• Link Shortcut Menu, page 2-34

• List View Shortcut Menu, page 2-35

• Links View Shortcut Menu, page 2-36

• Ticket Shortcut Menu, page 2-37

A menu is displayed when you right-click in many of the Cisco ANA NetworkVision windows or tables. 
For example, you can open a map from the Open Map dialog box using the right-click menu. The options 
displayed vary depending on the window or table currently displayed and the selection as described in 
the following topics. 

Table 2-21 Help Menu Options

Help Menu Option Description

Cisco ANA 
NetworkVision 
Help

Opens the online help for Cisco ANA NetworkVision and Cisco ANA 
EventVision.

Icon Legend Opens a window that identifies and describes the icons used in Cisco ANA.

Cisco ANA NSA 
Help

This option appears only if Cisco ANA Network Service Activation is installed 
with Cisco ANA. 

Opens the online help for the Cisco ANA Network Service Activation 
application.

Cisco.com This option is unavailable in this version.

About Cisco ANA 
NetworkVision

Displays application information about Cisco ANA NetworkVision and any 
additionally installed applications.
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Note • Based on the security level and access permissions assigned to a user, some menu options might not 
be available. 

• The menus are context-sensitive and the options vary according to your selection in the application; 
for example, the shortcut menus for NEs and aggregated nodes are different.

Device Shortcut Menu

The Device shortcut menu is displayed when you right-click a device in the navigation pane or in the 
content pane.

Note The Device shortcut menu is context-sensitive and the options vary depending on your selection in the 
application. Some options might not be available when multiple devices are selected.

Table 2-22 describes the options available in the device shortcut menu.

Table 2-22 Device Shortcut Menu Options

Device Shortcut 
Menu Option Description

Open VRF Table Opens the VRF Table window. For more information, see Viewing VRF 
Properties, page 17-18. 

Inventory Displays a window enabling you to view the physical and logical inventory. For 
physical inventory, you can view all the components of the device, such as the 
modules, ports, and its IP address or configured VLANs. In addition, you can 
view the status of each component. For logical inventory, you can view all the 
profiles and VC tables of the device. For more information, see Chapter 3, 
“Viewing Network Element Properties.”

Aggregate Groups the selected devices into an aggregation in the Cisco ANA 
NetworkVision content pane, and enables you to define a name for the new 
aggregated node. For more information, see Chapter 4, “Working with 
Cisco ANA NetworkVision Maps.”

Disaggregate Ungroups the devices in the selected aggregated node in the navigation pane and 
a map of the Cisco ANA NetworkVision window. For more information, see 
Chapter 4, “Working with Cisco ANA NetworkVision Maps.”

Note This option is available only when an aggregated node is selected in the 
navigation or a map.

Attach Business 
Tag

Attaches a business tag to the selected network element. For more information, 
see Chapter 6, “Working with Business Tags and Business Elements.”

Detach / Edit You can detach or edit a business tag from the selected NE. For more 
information, see Chapter 6, “Working with Business Tags and 
Business Elements.”

Note The Detach and Edit options are only displayed when a business tag is 
attached to an NE.
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Config Mgmnt Displays the Configuration Management page for the selected device in 
Cisco Active Network Abstraction Configuration and Image Management.

For more information, see the Cisco Active Network Abstraction 3.7.1 
Configuration and Image Management User and Administrator Guide.

Image Mgmnt Displays the Image Management page for the selected device in Cisco Active 
Network Abstraction Configuration and Image Management. 

For more information, see the Cisco Active Network Abstraction 3.7.1 
Configuration and Image Management User and Administrator Guide.

Filter Tickets Filters the tickets shown in the ticket pane so that only the tickets of a selected 
device or network element are displayed.

Resize Enables you to resize an object on the map by percentage or predefined sizes. 

Remove from Map Removes the selected device and all its children from the map (navigation pane 
and content pane). The device that has been removed is still maintained in the 
network.

Save as New Map Creates a new map and places the selected aggregation as the root, while leaving 
the original map intact.

Run Report Enables you to run standard or user-defined events, inventory, and network 
service reports on demand.

Add Associated 
VLAN

Opens the Add Associated VLAN dialog box so that you can add an associated 
VLAN to the selected VLAN. For more information, see Adding an Associated 
VLAN, page 12-43. 

Delete Deletes the selected item from the map.

Modify Displays the Modify dialog box so that you can change the selected item’s name, 
description, or icon.

Rename Renames the selected item. 

Show VRF Egress 
Adjacents

Displays the Adjacents window for the selected VRF. 

Show VRF Ingress 
Adjacents

Displays the Adjacents window for the selected VRF. 

Edit Move the selected item to the location you specify.

Show as 
Aggregation / 
Show Thumbnail

Displays the selected item as a single entity or as a collection of items.

Tools The Tools option contains the following choices:

• CPU Usage—Displays memory and CPU usage information for a device or 
network element.

• Ping—Pings the device from the client station.

• Telnet—Communicates with the device using the Telnet window from the 
client station.

Table 2-22 Device Shortcut Menu Options (continued)

Device Shortcut 
Menu Option Description
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Topology The Topology option enables you to add:

• A static link between two devices.

• A static topology between a device and an unmanaged network.

• A tunnel to a VPN. 

When working with static links, the following submenu options enable you to 
define the A Side and Z Side of the link:

• Mark as A Side

• Mark as Z Side

When working with VPNs in VPN Service View, the Add Tunnel submenu option 
allows you define and configure tunnels. 

Launch external 
applications

Starts an external application or tool that has been configured for access via the 
shortcut menu. For more information, see the Cisco Active Network Abstraction 
3.7.1 Customization User Guide. 

Script names Launches available activation and configuration scripts, including those you 
create using Command Builder (can be launched against multiple NEs). For more 
information, see the Cisco Active Network Abstraction 3.7.1 Customization User 
Guide. 

PathTracer Launches a path trace from the selected item.

Properties Displays the properties of the selected item, such as the IP address and system 
name. In addition, you can open the VNE Properties dialog box and manage VNE 
properties. For more information, see Chapter 3, “Viewing Network Element 
Properties.”

VNE Tools Changes the status of the VNE by starting or stopping it. For more information, 
see Chapter 3, “Viewing Network Element Properties.”

Management Contains the following submenu options:

• Command Builder—Defines commands and scripts using the Cisco ANA 
Command Builder tool (Configurator security level required). 

• Soft Properties Management—Extends VNEs by adding SNMP MIB or 
Telnet/SHH/TL-1 properties to the device’s collected information model 
using the Cisco ANA Soft Properties Manager (Administrator security level 
required). 

For more information about Command Builder and Soft Properties Manager, see 
the Cisco Active Network Abstraction 3.7.1 Customization User Guide.

Table 2-22 Device Shortcut Menu Options (continued)

Device Shortcut 
Menu Option Description
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Map Shortcut Menu

The Map shortcut menu is displayed when you right-click anywhere on a map in the content pane.

Table 2-23 describes the map shortcut menu options. 

Aggregated Node Shortcut Menu

The Aggregated Node shortcut menu is displayed when you right-click an aggregated node in a map.

Table 2-24 describes the aggregated node shortcut menu options. 

Table 2-23 Map Shortcut Menu Options

Map Shortcut 
Menu Option Description

Go to Parent Goes to the parent in the navigation pane and content pane to enable you to view 
different information.

Go to Root Goes to the root in the navigation pane and content pane to enable you to view 
different information.

Aggregate Creates an aggregation of the selected nodes in the navigation pane and a map in 
the Cisco ANA NetworkVision window and enables you to define a name for the 
aggregation. For more information, see Chapter 4, “Working with Cisco ANA 
NetworkVision Maps.”

Filter Tickets Filters the tickets shown in the ticket pane so that only the tickets of a selected 
device or network element are displayed.

Launch external 
applications

Launch external applications or tools, such as an SSH client. See the Cisco Active 
Network Abstraction 3.7.1 Customization User Guide. 

Script names Launches available activation and configuration scripts, including those you 
create using Command Builder (can be launched against multiple NEs). For more 
information, see the Cisco Active Network Abstraction 3.7.1 Customization User 
Guide. 

Add Associated 
VLAN

Opens the Add Associated VLAN dialog box so that you can add an associated 
VLAN to the selected VLAN. For more information, see Adding an Associated 
VLAN, page 12-43. 

Table 2-24 Aggregated Node Shortcut Menu Options

Aggregated Node 
Shortcut Menu 
Option Description

Aggregate Groups the selected aggregated nodes into an aggregation in the Cisco ANA 
NetworkVision content pane, and enables you to define a name for the new 
aggregated node. For more information, see Chapter 4, “Working with 
Cisco ANA NetworkVision Maps.”

Disaggregate Ungroups the selected aggregated node in the navigation pane and map in the 
Cisco ANA NetworkVision window. All the aggregations in the selected node 
move up one level, and the original aggregated node is removed. For more 
information, see Chapter 4, “Working with Cisco ANA NetworkVision Maps.”
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Link Shortcut Menu

The Link shortcut menu is displayed when you right-click a link in the map view. For more information, 
see Chapter 5, “Working with Links.”

Table 2-25 describes the link shortcut menu options.

Attach Business 
Tag

Attaches a business tag to the selected network element. For more information, 
see Chapter 6, “Working with Business Tags and Business Elements.”

Filter Tickets Filters the tickets shown in the ticket pane so that only the tickets of the selected 
aggregated node are displayed.

Rename Renames the selected aggregated node.

Resize Defines the size of selected aggregated nodes in a map according to predefined 
sizes or according to a percentage of the current size.

Remove from Map Removes the selected aggregated node and all its children from the navigation 
pane and the map. 

Save as New Map Creates a new map and places the selected aggregation as the root, while leaving 
the original map intact.

Add Associated 
VLAN

Opens the Add Associated VLAN dialog box so that you can add an associated 
VLAN to the selected VLAN. For more information, see Adding an Associated 
VLAN, page 12-43. 

Run Report Enables you to run standard or user-defined events, inventory, and network 
service reports.

Show Thumbnail Displays a thumbnail of the selected aggregated node in the content pane, 
including all aggregated devices.

Show as 
Aggregation

Displays the aggregated node in a map.

Note The Show as Aggregation option is displayed in the shortcut menu when 
a thumbnail is displayed in content pane.

Delete Deletes the selected item. 

Rename Enables you to rename the selected item.

Table 2-24 Aggregated Node Shortcut Menu Options (continued)

Aggregated Node 
Shortcut Menu 
Option Description

Table 2-25 Link Shortcut Menu Options

Link Shortcut 
Menu Option Description

Filter Tickets Filters the tickets shown in the ticket pane so that only the tickets of a selected 
network element are displayed.

Properties Displays the properties of the selected link.
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List View Shortcut Menu

The list view shortcut menu is displayed when you right-click an entry in the list view table displayed 
in the Cisco ANA NetworkVision content pane. For more information, see List View, page 2-10. 

Table 2-26 describes the list view shortcut menu options. 

Table 2-26 List View Shortcut Menu Options

List View Shortcut 
Menu Option Description

Inventory Displays a window enabling you to view the physical and logical inventory. 
For physical inventory, you can view all the components of the device, such 
as the modules, ports, and its IP address or configured VLANs. In addition, 
you can view the status of each component. For logical inventory, you can 
view all the profiles and VC tables of the device. For more information, see 
Chapter 3, “Viewing Network Element Properties.”

Attach Business 
Tag

Attaches a business tag to the selected link. For more information, see 
Chapter 6, “Working with Business Tags and Business Elements.”

Detach/Edit Detaches or edits a business tag from the selected link. For more 
information, see Chapter 6, “Working with Business Tags and 
Business Elements.”

Note The Detach and Edit options are only displayed when a business tag 
is attached to a link.

Run Report Enables you to run standard or user-defined events, inventory, and network 
service reports.

Show Only 
Selected Rows

Displays only the rows that you select. 

For more information, see Viewing Selected Rows, page 2-45.

Show All Rows Displays all table rows that meet the current filtering criteria.

Tools Contains the following submenu options:

• CPU Usage—Displays memory and CPU usage information for a device 
or network element.

• Ping—Pings the device from the client station.

• Telnet—Communicates with the device using the Telnet window from 
the client station.

Topology Enables you to add:

• A static link between two devices.

• A static topology between a device and an unmanaged network.

• A tunnel to a VPN. 

When working with static links, the following submenu options enable you 
to define the A Side and Z Side of the link:

• Mark as A Side

• Mark as Z Side

When working with VPNs in VPN Service View, the Add Tunnel submenu 
option allows you define and configure tunnels. 
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Links View Shortcut Menu

The links view shortcut menu is displayed when you right-click a link in the links view table displayed 
in the Cisco ANA NetworkVision content pane. For more information, see Chapter 5, “Working with 
Links.”

Table 2-27 describes the links view shortcut menu options.

Launch external 
applications

Launches external applications or tools, such as an SSH client. See the 
Cisco Active Network Abstraction 3.7.1 Customization User Guide. 

Properties Displays the properties of the selected item, such as the IP address and 
system name. In addition, you can open the VNE Properties dialog box and 
manage VNE properties. For more information, see Chapter 3, “Viewing 
Network Element Properties.”

Script names Launches available activation and configuration scripts, including those you 
create using Command Builder (can be launched against multiple NEs). For 
more information, see the Cisco Active Network Abstraction 3.7.1 
Customization User Guide. 

VNE Tools Changes the status of the VNE by starting or stopping it. For more 
information, see Chapter 3, “Viewing Network Element Properties.”

Management Contains the following submenu options:

• Command Builder—Defines commands and scripts using the 
Cisco ANA Command Builder tool (Configurator security level 
required). 

• Soft Properties Management—Extends VNEs by adding SNMP MIB or 
Telnet/SHH/TL-1 properties to the device’s collected information model 
using the Cisco ANA Soft Properties Manager (Administrator security 
level required). 

For more information about Command Builder and Soft Properties Manager, 
see the Cisco Active Network Abstraction 3.7.1 Customization User Guide.

Table 2-26 List View Shortcut Menu Options (continued)

List View Shortcut 
Menu Option Description

Table 2-27 Links View Shortcut Menu Options

Links View Shortcut 
Menu Option Description

Attach Business 
Tag

Attaches a business tag to the selected link. For more information, see Chapter 6, 
“Working with Business Tags and Business Elements.”

Detach/Edit Detaches or edits a business tag from the selected link. For more information, see 
Chapter 6, “Working with Business Tags and Business Elements.”

Note The Detach and Edit options are only displayed when a business tag is 
attached to a link.

Select Link in Map Highlights the selected link in the content pane.
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Ticket Shortcut Menu

The Ticket shortcut menu is displayed when you right-click a ticket in the ticket pane. The Ticket 
shortcut menu enables you to view ticket properties and highlights the links or elements that are affected 
by a ticket. The Ticket menu also enables you to acknowledge, clear, and remove a ticket. For more 
information, see Chapter 9, “Working with Tickets in Cisco ANA NetworkVision.”

Table 2-28 describes the ticket shortcut menu options.

Show Only 
Selected Rows

Displays only the rows that you select. 

For more information, see Viewing Selected Rows, page 2-45.

Show All Rows Displays all table rows that meet the current filtering criteria.

Properties Displays the properties of the selected link.

Table 2-27 Links View Shortcut Menu Options (continued)

Links View Shortcut 
Menu Option Description

Table 2-28 Ticket Shortcut Menu Options

Ticket Shortcut 
Menu Option Description

Acknowledge Acknowledges that the ticket is being handled; the ticket is displayed as true in 
the ticket pane. Acknowledging an alarm removes the alarm icon from the device 
icon. Multiple tickets can be acknowledged at the same time.

Clear Approves the reported faulty ticket and clears the faulty networking entity from 
Cisco ANA. The ticket is displayed as Clear in the ticket pane.

Note When a Card Out or Link Down alarm occurs, the relevant information is 
displayed in the inventory and maintained in the VNE.

Remove Removes the ticket and all its active subtickets from the ticket pane (this option 
is only available after the ticket has been cleared). The deleted tickets can be 
viewed using Cisco ANA EventVision. Multiple tickets can be removed at the 
same time.

Note When a ticket is removed, the information is no longer displayed in the 
inventory and is removed from the VNE.

Clear and Remove Approves the reported faulty ticket and clears the faulty networking entity from 
Cisco ANA. In addition, the ticket and all its active subtickets are removed from 
the ticket pane.

Find Affected 
Elements

Finds any elements affected by the selected ticket: 

• If only one element is affected, it is selected in the Cisco ANA 
NetworkVision navigation pane and content area.

• If multiple elements are affected, they are displayed in the Affected 
Elements window.

Show Only 
Selected Rows

Displays only the rows that you select. 

For more information, see Viewing Selected Rows, page 2-45.
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Changing a User Password in Cisco ANA NetworkVision
Cisco ANA enables you to provide authentication by Cisco ANA or an external Lightweight Directory 
Access Protocol (LDAP) server. The method used to change your password depends on whether 
authentication is provided by Cisco ANA or an LDAP server: 

• If Cisco ANA provides login authentication, Cisco ANA NetworkVision enables you to change your 
login password. If needed, the administrator can also change your password in Cisco ANA Manage.

• If Cisco ANA uses an LDAP server for authentication, you cannot change your password in 
Cisco ANA NetworkVision. Only users with Administrator privileges can change your password, 
which must be done on the LDAP server. 

– For more information about external authentication, see the Cisco Active Network Abstraction 
3.7.1 Customization User Guide.

– For more information about password guidelines, see the Cisco Active Network Abstraction 
3.7.1 Administrator Guide. 

To change your password: 

Step 1 Choose Tools > Change User Password. The Change User Password dialog box is displayed.

Note If Cisco ANA uses an LDAP server for authentication, the Change User Password option is 
dimmed. Contact your administrator to change your password on the LDAP server.

Step 2 Enter the following information: 

• Old password—Enter the old user password.

• New password—Enter the new user password.

• Confirm password—Enter the new password again to confirm the entry.

Step 3 Click OK. The change takes effect the next time you log into the application.

Show All Rows Displays all table rows that meet the current filtering criteria.

Properties Displays the Ticket Properties dialog box, enabling you to view ticket 
information, including impact analysis details of the affected parties and 
correlated alarms. See Viewing Ticket Properties, page 9-7.

Table 2-28 Ticket Shortcut Menu Options (continued)

Ticket Shortcut 
Menu Option Description
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Selecting Cisco ANA NetworkVision Map and Alarm Options
Cisco ANA NetworkVision enables you to select map, display, and audio options. 

To select Cisco ANA NetworkVision options: 

Step 1 Choose Tools > Options from the main menu. 

Step 2 In the Startup tab, check the Load Workspace on Startup check box to automatically view the content 
pane when you log in. Uncheck the check box if you do not want to view the content pane when you log 
in.

Step 3 Click the Display tab. Set the display options using the information in the following table. 

Step 4 Click the Audio tab.

Table 2-29 Cisco ANA NetworkVision Display Options

Field Description

Preferences

Map Labels Font Size In the drop-down list, choose the preferred font size for labels on maps. 
Font sizes range from 10 to 14, with a default of 12.

Severity

Show Severity Text
(e.g. [3M+]

Check the check box to view severity labels in the navigation pane and 
maps, using the formula described in New Ticket Propagation, 
page 2-18. 

Uncheck the check box to hide severity labels. 

Show Acknowledged Check the check box to view the number of both acknowledged and 
unacknowledged alarms in the network element display name.

Uncheck the check box to view only the number of unacknowledged 
alarms in the network element display name. 

For example, assume that device NE1 has two alarms with the severity 
M. One of these two alarms is acknowledged, and the other is not. If 
you check the Show Acknowledged check box, the display name will 
be NE1 [2M]. If you uncheck the Show Acknowledged check box, the 
display name will be NE1 [1M]. 

Show Propagated Check the check box to view propagated alarms on the specific entity. 

Uncheck the check box to view only the alarms on the specific entity. 

Display Name

Display Name Select the preferred setting for network element names:

• Do not use Business Tag—Displays the original network element 
name only.

• Add Business Tag to name—Displays the original network element 
name and the name of the business tag.

• Replace name with Business Tag—Replaces the network element 
name with the name of the business tag. When a subscriber is 
attached to a port, the name of the subscriber is also added.
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Step 5 Select your preferences for audio notifications:

a. Check the Enable Audio Response for Alarm check box to indicate that a sound is to be issued when 
an alarm is triggered. Uncheck the check box to prevent a sound from being issued when an alarm 
is triggered.

b. In the Critical field, specify the .wav file to use for critical alarms. 

c. In the Major field, specify the .wav file to use for major alarms.

d. In the Minor field, specify the .wav file to use for minor alarms. 

e. Check the Loop Sound on Critical Alarm check box to play the critical alarm sound continuously 
when a critical alarm is triggered. Uncheck the check box to play the critical alarm sound only once 
when a critical alarm is triggered.

Step 6 Click Apply to apply your selections. 

Step 7 Click OK. 

Working with Cisco ANA Tables
Cisco ANA uses tables to display different types of information. The following topics describe how to 
work with Cisco ANA tables so that you can view the information that you want and, optionally, save 
the information to a file:

• Table Toolbar Options, page 2-40

• Finding Text in a Table, page 2-41

• Sorting a Table, page 2-42

• Filtering Table Contents, page 2-43

• Viewing Selected Rows, page 2-45

• Exporting Tables to a File, page 2-45

To view all text in a table cell, you can do either of the following: 

• Click the red triangle in the cell to automatically expand the cell to the size of the cell’s contents.

• Hover your mouse cursor over the cell. 

Table Toolbar Options
Table 2-30 describes the options available in table toolbars. 
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Finding Text in a Table
Cisco ANA enables you to search for information about a specific network object in a table by entering 
search criteria, such as a partial IP address. 

Table 2-31 lists the keyboard shortcuts that you can use when working with tables. 

Table 2-30 Table Toolbar Options

Option Name Description

Find Searches the current table for the string you enter. 

For more information, see Finding Text in a Table, 
page 2-41. 

Export to CSV Exports the information displayed in the table, or 
selected portions, to a CSV file. 

For more information, see Exporting Tables to a 
File, page 2-45

Sort Table Values Sorts the information displayed in the table by the 
criteria you specify. 

For more information, see Sorting a Table, 
page 2-42.

Filter Filters the information displayed in the table by the 
criteria you specify. 

For more information, see Filtering Table Contents, 
page 2-43.

Clear Filter Clears the existing filter. 

Show All Rows Displays all table rows that meet the current filtering 
criteria.

Show Only Selected 
Rows

Displays only the rows that you select. 

For more information, see Viewing Selected Rows, 
page 2-45.

Table 2-31 Keyboard Shortcuts for Tables

Keyboard Shortcut Description

Ctrl + A Selects all the rows in the table.

Ctrl + Space Deselects all the rows in the table.

Enter On a selected row, opens the default action.

Arrow Navigation Keys Navigates up and down in the rows.

Ctrl + Up/Down Keeps the selected row and moves up or down.

Ctrl + Up/Down + Space Keeps the selected row and moves up or down. The space selects 
the required row.
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To find text in a table: 

Step 1 In the Find field on the toolbar, enter the search criterion for the entity that you want to find and press 
Enter. 

Step 2 Press F3 to continue searching the table or press Ctrl + F to return to the Find field.

Sorting a Table
Cisco ANA NetworkVision enables you to sort a table in one or more of the following ways:

• According to a column, by clicking the required column heading. The  icon is displayed next to 
the selected column heading, indicating continuous sorting.

• In ascending or descending order, by clicking a column heading.

• By clicking Sort Table Values in the toolbar and specifying sort criteria. 

A triangle next to the column heading indicates the property by which the table is sorted.

To sort a table using the Sort Table Values option: 

Step 1 In the table toolbar, click Sort Table Values. The Sort dialog box is displayed. 

Step 2 Enter the required information as defined in Table 2-32: 

Shift + Up/Down Keeps the selected row and selects all the rows that are above or 
below it.

Shift + F10 Opens the shortcut menu.

F3 Finds next.

Shift + F3 Finds previous.

Table 2-31 Keyboard Shortcuts for Tables (continued)

Keyboard Shortcut Description

Table 2-32 Sort Table Values Dialog Box

Field Description

Sort By Specify the first sort criterion:

1. In the drop-down list, select the column to use for the first sort 
criterion. 

2. Click the Ascending or Descending radio button to indicate the 
sort order. 
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Step 3 Click OK. The table information is sorted according to the filter defined.

Filtering Table Contents
By filtering a table’s contents, you can view only those items that are of interest to you. This feature can 
be extremely helpful when working with tables that contain many entries. 

Note If you load a table with many entries, (for example, thousands of entries), it can take a while for the 
complete table to load. The filtering options in the table toolbar are unavailable until the table has 
completely loaded. 

The following changes in the GUI indicate that a filter has been applied:

• The Filter button is slightly shaded.

• The Clear Filter button becomes active.

• The filter details are displayed:

– In the status line below the table.

– When you hover the mouse cursor over the Filter button.

To define a filter: 

Step 1 In the toolbar above the table, click Filter. The Filter dialog box is displayed as shown in Figure 2-7.

Then By (Optional) Specify the next sort criterion:

1. In the drop-down list, select the column to use for the second 
sort criteria. 

2. Click the Ascending or Descending radio button to indicate the 
sort order. 

Sort Operation Specify the frequency of the sort operation by clicking the 
appropriate radio button:

• Only Once—Sorts the information in the table only once 
according to the specified criteria. 

• Continuously/Repeatedly—Sorts the information in the table 
continuously according to the specified criteria. 

If you select this option, the  icon is displayed next to the 
selected column heading.

Table 2-32 Sort Table Values Dialog Box (continued)

Field Description
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Figure 2-7 Table Filter Dialog Box

Step 2 In the Match drop-down list, choose the rule for including items that meet the specified criteria: 

• All—All of the following criteria are to be met.

• Any—Any of the following criteria are to be met. 

Step 3 For each criterion, specify the following information:

a. In the first drop-down list, choose the primary match category. The drop-down list contains all 
columns in the current table. 

b. In the second-drop down list, list choose the rule to use for this criterion. The options are:

– Contains

– Does not contain

– Equals

– Does not equal

– Greater than

– Less than

c. The third field either lists the available values or allows you to enter text: 

– If a drop-down list is displayed, choose the required entry. 

– If an entry field is displayed, enter a string or regular expression for the criterion. Any entry that 
is not a regular expression is treated as a string.

Step 4 Click  to add another criterion for this filter. 

Step 5 Add additional criteria as required. To remove a criterion, click .

Step 6 When you have specified all criteria for the filter, click OK. 

The table data is displayed using the defined filter. 

Step 7 To clear a filter, click Clear Filter in the table toolbar.

The table is refreshed and all entries are displayed.

The following tables have additional filtering capabilities: 

• Cisco ANA NetworkVision ticket pane. For more information, see Filtering Tickets by Criteria, 
page 9-6.

• Links view in the content pane. For more information, see Links View, page 2-13. 
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Viewing Selected Rows
Cisco ANA enables you to select a line or a specific set of lines, and display them in the table. The lines 
that you do not select are hidden from view. 

You can use this feature with the filtering mechanism to view the specific entries that you need. You can 
either select specific rows and then apply a filter, or you can filter the table’s contents and then select 
specific rows to view. 

If you apply a filter, the details of the filter are displayed below the table. For example, if you apply a 
filter that specifies all elements with names containing ME are to be displayed, the following appears in 
the table status line: 

Filter: ‘Name’ Contains ME 

The status bar below the table also displays the: 

• Number of rows selected, if any.

• Number of the selected row, if a row is selected. 

• Total number of rows currently displayed in the table. 

For example, if you select line four in a table with six rows, the following information is displayed: 

Line 4 (1/6 Selected)

If no rows are selected, the value for the line defaults to 0, such as:

Line 0 (Size 6)

To view selected rows:

Step 1 Select the appropriate line or lines in the table using standard Windows mouse or keystroke operations.

Step 2 Click Show Only Selected Rows. 

The table displays the selected rows, and the Show All Rows option becomes active.

Step 3 Click Show All Rows to view all rows in the table. 

Exporting Tables to a File
Cisco ANA enables you to export the currently displayed data from a table. You can either select specific 
rows to export, or clear all selections in the table to export the entire table. The data can then be imported 
and viewed at a later stage. 

To export a table to a file: 

Step 1 Press Ctrl + Space to clear any existing selection.

Step 2 Identify the content you want to export:

• To export specific rows, select the required rows. 

• To export the entire table, ensure that nothing is selected.

Step 3 In the toolbar above the table, click Export to CSV. The Export Table to File dialog box is displayed.

Step 4 Browse to the directory where you want to save the table.
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Step 5 In the File name field, enter a name for the table.

Step 6 Click Save. The content specified in Step 2 is saved in the selected directory.
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